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SOFTWARE FEATURES 
 
 Sierra StarTime TMS 
 
• System configuration support up to a maximum of 8 multiple Communication ports 
simultaneously. 
 
• Remote dial-up window with dialing status display. Inclusive of modem remote dial-up and 
modem scheduling feature for each communications port with remote dial-up scheduler task program 
for each communications port, e.g. hourly, daily, weekly, etc. (Available and enabled only for dial-out 
feature). 
•  
• Each communications port can be defined to save and allocate data in different output format, 
filename and file location. 
 
• Each communications port has its own configuration file (configcomN.txt, where N=comport 
number). If it doesn’t exist once at present, the system will automatically creates one from the original 
configuration file (config.txt). Hence, the config.txt must be present for it to duplicate to 
configComN.txt file. 
 
• Built-in online transactions printing feature via parallel printer port (Not supported under 
Window NT and Windows 2000). 
 
• Enable and Disable capability to Synchronize Clock Reader with PC’s date & time. 
 
• Automatic creation of backup copy features. Besides that, User can create a backup copy of the 
transactions to another file, which is a daily transaction file, TRyymmdd.txt, where yymmdd represents 
the year, month and day of the transaction. 
 
• User selection password protected feature. 
 
• Employee data can now be display in a view form. User can add, delete, enabled/disabled 
employees in the display grid. Furthermore, employee data can be sort by clicking on the column 
header and load or import data in Excel format. 
 
• In load config on startup, the loading of clock data and employee can now be selected. 
 
• Loading of employee will now have display to indicate the percentage already downloaded 
when you refresh the comport configuration. 
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StarTime's Main Screen 
 
Sample layout for StarTime window is shown below. 
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INSTALLATION GUIDE 
 
1. Lantronix Redirector 
 
This is the application software that will communicate with its devices via Ethernet. Install this 
application if the hardware configuration requires it. 
 
1.1 Run Setup.exe from the installation disk. 
1.2 Follow through the installation guide and select the directory to install to or choose its default 
value. 
1.3 Once installed, run the application to setup the comport. 
1.4 Click Com Setup. Select the comport that is to be redirected. Click OK to accept the selected 
comport. 
 

 
1.5 From the Port Configuration, select the comport. If the redirect comport is to use TCP/IP, click 
Add IP_ button to add IP address. 
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1.6 At the IP Service Setup, Enter the IP address in the Host input and enter value 3000 in the 
TCPPort. Click OK when done. 
1.7 Repeat step 1.5 - 1.6 until all the comport is configured. 
1.8 Click Save to save the comport setup. The application will prompt you to restart the pc for the 
configuration to take effect. Click Yes if you want to restart the pc now or No for later. 
1.9 At this point you have completed the comport redirector setup. Congratulation! 
 
2. StarTime 2.11.x 
 
This is the software that will communicate with the clock readers. Please note that if the OS is 
Windows NT, you will need to install it from administrator login. 
 
2.1 Run Setup.exe from the installation disk. 
2.2 Follow through the installation guide and select the directory to install to or choose its default 
value. 
2.3 Launch the application (You can go to Start->Programs->Sierra Technology->StarTime). 
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2.4 You can design the output format from the Options button . Otherwise, the application will 
use its default format. If it prompts for password, enter ‘Sierra’, with case sensitive letter. See the 
manual on how to design you own output format. Use other number than 0 for your own format. 
You can disable the password prompt from the Password button. 

2.5 Select Comport Setup to setup the comport. Activate the comports to be used by ticking at 
its active checkbox.  

 
If the comport is to be connected directly to the clock reader via RS485/RS232, make sure its Type is 
set to direct. If the comport is to be connected to a modem, set its Type to modem. 
2.6  Assign the comport’s output format to the one that you have designed by selecting the File 
Format’s value to your format value. Otherwise, it will use the default value, 0. 
 

 
2.7 Make sure that under Start Up column, the value is set to poll, so that, when the application 
startup, it will start to poll. 
2.8 Close this comport setup with the OK button to accept the new setting. By doing so, the 
application will activate the comport(s) selected. 
2.9 If you want the application to start up on Windows startup and minimize it to a traybar (traybar- 
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a rectangular area that enclose the Windows’ time inside the taskbar), go to Options setup , tick at 
the checkbox beside Run when Windows start and Minimize poller to Tray, respectively. 
 

 
2.10 In the main form, tick Enable All Polling to enable all comports to poll. You can disable all 
polling by uncheck this checkbox. 

 
Please notes that polling for each comport, too, can be controlled from the Polling checkbox just above 
the comport selection tab. 
2.11 At this point, if there is time clock reader already connected, the application will highlight 
(green box) the reader according to its address in the time clock address box (The area with the number 
boxes). A red box means the reader of this number address is not available or has not been reached. 

 
2.12 Congratulation, you have reached the end of StarTime installation. 
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3. Re-installation guide 
 
3.1 LAN Redirector 
 
3.1.1. Follow the instruction as same as the mentioned on above. 
 
3.2 StarTime 2.11.x 
 
3.2.1. Follow the instruction as same as above, but up to step 2.2 only if the configuration is still intact, 
otherwise, follow the instruction all the way through. 
 
4. Backup 
 
Once, you have confirmed the setup is correct and accordingly, make the backup to different location, 
e.g. to different hard disk or floppy disk. 
 
4.1 Lantronix redirector 
 
4.1.1. Note down the comport number you have selected from the Port Setup. 
4.1.2. For each comport you have selected, if you’re using TCP/IP connection, note down its IP 
address and TCP port number. 
 
4.2 StarTime 2.11.x 
 
Backup these files: 
4.2.1. Comm.ini {all the setting including the comport setting} 
4.2.2. Empdata.txt {employee data file} 
4.2.3. All the ConfigComN.txt where N is a number corresponding to comport number. {Clock setting 
at comport N} 
4.2.4. LogFmt.ini {user defined output format} 
4.2.5. Stexp.sys  {system file} 
4.2.6. Tms.pwd  {password file} 
4.2.7. RemoteCmdAll.txt     {remote command file} 
 
5. Disaster Recovery guide 
 
5.1 Lantronix Redirector: Check and see if the comport configuration for the Lantronix devices is 
correct. 
5.1.1. Run the Lantronix Redirector. If the Redirector fails to run due to a ‘disaster’ event, you may 
need to re-install it again (See reinstallation guide for Lantronix) 
5.1.2. Click the Port Setup. Check if the correct comports are selected. If not, select it again. 
5.1.3. From the Port Configuration, check for each comport if the IP address and the TCP port number 
is correct (TCP/IP connection). If there are differences from the Lantronix backup notes (See Backup, 
section 4.1), delete the wrong IP address by selecting the wrong IP address and click Remove button. 
Add the correct IP address and TCP port number for that comport again (See Installation guide for 
Lantronix Redirector
5.1.4. Click Save button to save the new configuration again. 

). 
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5.2 StarTime 2.11.x 
 
5.2.1. In the event of ‘disaster’ occurred, if StarTime application cannot be run again, you will have to 
do a full installation again. 
5.2.2. If you did a full installation, you will need to restore back its previous setting and configuration. 
Just copy back the backup files you have done (See Backup, section 4.2

5.2.3. Run the StarTime application and click the Retrieve Transaction button . Select which 
comport and controller number to retrieve previous transactions from. Enter a previous transaction 
count, say, about 600. This means it will retrieve the last 600 transactions record. You may need to 
increase this number if you suspect there may be more transactions to retrieve. 

 ) to StarTime directory. 

 

 
 
 
 
 
 
 

 
Back to Installation Guide 
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PASSWORD 
 
Most of the functional buttons (etc: Employee Data button, Comport Setup button) are password 
protected by default. This is to prevent unauthorized user from changing any setting or configuration 
already setup. Nevertheless, the password can be enabled or disabled by the user. The password is also 
case-sensitive. 
 
Steps: 

1. Proceed to the main page and click on (Change Password) button. 
 
2. Follow the steps below to change the password: 
i.    Enter the current password in the current password entry box. 
ii.   Enter the new password in the new password entry box. 
iii.  Enter the new password again in the repeat new password entry box. 
iv.  Click OK to accept the changes. 
 
If the user doesn’t require the use of password when clicking on any functional buttons, just uncheck 
the Enable checkbox. Tick the checkbox if the use of password is required. 
 
NOTES: The default password is ‘Sierra’. 
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EMPLOYEE DATA 
 
The employees’ data are stored into a text file titled 'Empdata.txt'. This file must be in the same 
directory as where the applications software is installed. 
 
User can add, delete, enabled/disabled employees in the display grid. User can also directly edit the 
employee data in the grid itself, find data, sorting the data field, load and export data in Excel format. 
 
 Steps:           

1. Proceed to main page and click on (Edit Employee Data) button. 
 
2. If the password is enabled, then the system will prompt you with a Password Dialog Window to 
request user to key-in a valid password in order to proceed to Employee Data.txt file. 
 
3. The following window will then appear on the screen. 

 
 
Click on any control buttons to know more information. 
 
4. Click ‘Save’ button or press shortcut key F4 to save all the changes that have made. 
 
5. Click ‘Close’ button or click on the button on the title bar to quit this employee data 
window. 
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Important: - 
 

For new changes to take effect, user must refresh all the connected clock readers. Click Refresh 
Configuration button for the new configurations to take effect. Each comport will indicate the 
percentage already downloaded. 
 
Note : Load or export data in Excel format : The user’s PC must have the Excel Ole server installed. 
This application does not provide such server. The data in the Excel format must be in the order of 
cardno, staffname, and staffno. The application will only read the first three columns. 
 
 
 
 
Related Topic 

 
How to edit Employee Data 
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OPTIONS 
 
Settings  
 
Snap To Main Window - By enabling this feature, the online Monitoring Windows will be arranged in 
such a way that it will be attached or snap to the main application window at all times for ease of view. 
 
Run when Windows Starts - When this feature has been enabled, the applications software will 
automatically run or execute upon Windows start up. 
 
Minimize TMS Poller in Tray - When enabling this feature, the applications window will be 
automatically minimized to the traybar when StarTime is minimized. Tips: Right click on the StarTime 
icon in the traybar to operate the software. 
 
Load Config on Startup - When this feature has been enabled, the system will automatically 
download all configuration settings of the system to the clock readers upon every start up attempts of 
applications software. Users have the options to select load clock configuration and load employee data. 
 
 Load clock configuration - if this feature is selected, the system will download all clock 
 configuration settings when application startup. 
 
 Load employee data - if this feature is selected, the system will download all the employee 
 data when application startup. 
 
Note: Loading of employee, which normally will take a longer period of time, will now have a display 
to indicate the percentage already downloaded. 
 
Output  
 
The application will generate an ASCII text file for every valid transaction. The output file format can 
be configured by user in this section. User can select whether output file format is a fixed name or 
changeable by date. The output format filename, by default is named as Translog. This name can be 
changed later on in Comport Setup. 
 
Format Type 
 
The output file format can be created according to user preferences. There are maximum of 98 Format 
Type #, available in this system. 
 
 Note: Format Type # 0 is reserved for default. 
 

 
Click here on how to create an own unique output file format. 

Note: After defining the personal output format, you will need to proceed to Comport Setup to assign 
this new Format Type number to the required Communications Port. 
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Edit 
 
This function is for you to create a new output file format type. To add a new output format type, click 
on the up arrow to select Format Type # other than 0 (0 is reserved for default) and click ‘Edit’ button. 
An Edit Output Format window will be shown on the screen. Refer here

 

 to follow the guidelines to edit 
the output file format. To edit an existing output file format, select the desired Format Type # that you 
want to edit and then click ‘Edit’ button. After the changes have been made, click ‘Save’. 

Delete 
 
To delete an unnecessary output file format, select the unwanted Format Type # and then click ‘delete’ 
button. 
 
Sample 
 
This function button is for you to view the output file format that you have created previously. Select 
the Format Type #, and click ‘Sample’ button. You will see a result of the output file format that you 
defined previously. 
 
 
 
 
 
Related Topic 

 
Comports Setup 
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COMPORTS SETUP 
 
The Comport setup is to establish communications between the hardware of the StarTime clock reader 
with the host computer. 
 

To set the communications port, simply proceed to the main window and select Comport Setup to 
activate the required comport. If the user are not sure which comports are connected to the Sierra’s 
clock reader, user can request the system to detect the hardware for them by clicking on the DETECT 
button in the Comport Setup window. 
 
Notes: This detection only works for comport with direct connection type. It does not work with the 
type as Modem. 
 
Apart from that, all additional features can be edited by simply double click on the value in the 
concerned column. 

 
 
Com no. - The software supports up to a maximum of 8 multiple Communication port simultaneously. 
 
Type - The system have two connection types, i.e. Direct and Modem. Select Modem type if you have 
installed a modem. 
 
Active - This is to select which comport to be active. User may enable and disable this feature to 
activate or deactivate the communication ports. 
 
Synchronize date/time - Enable and Disable capability to Synchronize Clock Reader with PC’s date & 
time. 
Create backup copy - A backup copy will be created automatically if you had enabled this feature. 
The backup copies are saved into the Backup folder in StarTime Directory (C:\Program files\Sierra 
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Technology\StarTime\Backup) with the filename of Tryymmdd.txt (which is By Date format). 
Phone and Modem Init - If you are selected the Modem type then you need to key in the dialing 
phone number and modem initialises fields. (Note: These two fields are optional). 
 
Start up - When StarTime is start up, the system will start polling the data. There are 3 options to be 
select, i.e. do nothing, poll and dial then poll. Poll is the default setting. 
 
Output file - User can select whether the Output file format type as a Fixed name or changeable By 
date. If you are select the output format as the type change by date, then the system will automatically 
generate filename as ‘tr’ + yymmdd + ’.txt’, where yymmdd is define as year, month and day of the 
transaction date. E.g. If the transaction date is 23rd Jan 2001, the system will generate file tr010424.txt. 
 
If you select the output format with the type Fixed name, then you may named your output filename as 
you like in the File name field. 
 
File name - If your Output file type is fixed name, then you can type a user defined filename. The 
output format filename by default is named as Translog. 
 
File format - Select the output format type # which you had defined in the Option > Output menu. 
 
 
File Location - This is the location of the output file. User can save the output file in any location as 
they like. Default is in the installed directory (StarTime Directory). 
 
Scheduling - This is only applied for the Modem type. Schedule can be set in a Hourly, Daily, Weekly, 
On weekdays, Monthly or no scheduling mode. Furthermore, user can set how many seconds to close 
the connection of no data receiving. 
 
From the comport setup window, select the scheduling column of the comport that is set to modem type. 
Click the input box again until the ellipsis button appeared. Click the ellipsis button at the right side of 
the input box. Then the following window will show on screen. Click here on how to use the 
scheduling features

               

. 
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NOTE: Any changes made to these files will require the user to refresh the controller/clock readers. 

Click on Refresh Configuration button to enable the new configurations to take effect. 
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CONFIGURATION FILE 
 
Each communications port has its own configuration file i.e.ConfigComN.Txt, where N = comport 
number for the clock settings. To open the configuration file of comport, simply proceed to main 

window of StarTime and click on the (Configuration) button. Select which comport you want to 
load and click ‘open’ button. A configComN.Txt with the Notepad format will be displayed on the 
screen. The explanation of terms used in the configuration file is describes below. 
 
          Type  Term   Description 
 
 1. Main, ”TMS Clock ” Message display to LCD. 
 
 2. Mode, 1, Clock In For use with keypad number. 
     Mode, <key>, <description> 
     Key = 0 - 9. Maximum characters for 
     the description displayed is 10.  
     Mode 0 - keypad 0 
     Mode 1 - keypad1 and so on   
  
 3. Siren, 1, 0, 9.00, 15 Siren,<day>,<setting>,<time>,<duration> 
     Siren on Monday, setting 0, at time 9.00 am 
     for 15 seconds. 
     Siren, 2,1,13.00, 20 Siren on Tuesday, setting 1, at time 1.00 pm 
     for 20 seconds. 
     0 - Sunday 3 - Wednesday      
     1 - Monday 4 - Thursday 
     2 - Tuesday 5 -  Friday  
     6 - Saturday 
 
 4. CheckCard, x  where x = 0 or 1. 
     0 = Accepts any or all card. 
     1 = Accepts only installed cards from EmpDataTxt. 
 
 5. IndicatorTime, 5 Trigger relay on valid swipe for 5 seconds. Time   
     setting from 0 - 99 seconds.  
 
Example of config.txt contents 
 
Main, ”TMS Clock“ 
Mode, 1,Morning In 
Siren, 1, 0,9:00,15 
Siren, 2,0,13:00,20 
CheckCard, 0 
IndicatorTime, 5 
 
NOTE: For new changes of settings to take effect, user must refresh to all the connected clock readers. 
Click REFRESH button to refresh or upload the entire new configurations for the changes to happen. 
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REFRESH CONFIGURATION 
 
This function is to enable the new configurations to take effect. Any changes made to the employee file 
or clock configuration files will require the user to refresh the controller/clock readers for the new 
configurations to take effect. 
 
 
Steps:                         
 

1. Proceed to main screen and click on Refresh Configuration button. 
2. Select the desired comport or tick the All Comports box for all comports. 
3. Select or unselect the load options as desired. As defaults, all will be selected. 
4. Click on the ‘Refresh’ button to update the configuration settings. 
5. Wait for the process to be finished, then, click ‘Close’ button to quit. 
 
Note: Each comport will indicate the percentage already downloaded. 
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RETRIEVE TRANSACTION 
 
This function allows the user to retrieve up to the last 25000 previous transactions. Proceed to main 

window and click Retrieve Transaction button. Select the ComPort No, Controller No and No. of 
Trans to Get required and click on the START button to execute. 
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ABOUT 
 
This function enables you to check the software‘s version. 

Simply click on the About button to check. 
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ADD COMMUNICATION PORTS 
 
Steps: 
 

1. Proceed to the main window and click on Comport Setup button. 
2. Select which communication port to be activated. 

3. Double click on the value in the type field to select type as a direct type. 

4. Enable the Synchronize date/time if you want to always synchronize the Clock 
Reader with PC’s date & time. 

5. Enable the Create Backup Copy if you want to create a backup copy 
automatically. The backup copies will be saved into the Backup folder in StarTime Directory 
(C:\Program files\Sierra Technology\ StarTime\ Backup) with the filename of Tryymmdd.txt (which is 
By Date format). 

6. Double click on the value in the Output file field to select whether the Output file 
will be saved as a fixed name or changeable by date. If you select the output format as the type change 
by date, then the system will automatically generate filename as ‘tr’ + yymmdd + ’.txt’, where yymmdd 
is define as year, month and day of the transaction date. E.g. If the transaction date is 23rd Jan 2001, 
the system will generate file tr010424.txt.  If you select the output format with the type Fixed name, 
then you may named your output filename as you like in the File name field. 

7. Double click on the value in the File Format field to select the output format type # 
which you had defined in the Option > Output menu. 

8. Click on the value in the File name field and press enter to type a user defined 
filename. Note: User can only named the filename if the Output file type is fixed name. The output 
format filename by default is named as Translog. This field will be ignored if the output file field was 
selected changeable by date. 

Jump to the topic of how to create a user defined 
output file format. 

9. Double click on the value in the File Location field . Then, a Browse for Folder 
dialog box will appear on screen. Select your desired directory to save the output file and then press ‘ok’ 
button. As default is in the installed directory (StarTime Directory). 
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 ADD COMPORT WITH MODEM TYPE 
 
Adding a comport with modem type is as similar as to add a comport with direct type, except for the 
following features of the modem type: - 
 
Steps: 
 
1. Select the comport that is connected to modem. 

2. Double click on the value in the Type field and select the type as modem type. Note: 
if you have installed a modem then you need to select modem type. 

3. You can key in the dialing phone number and modem initialize fields under 
the ‘Phone’ and ‘modem initialization’ string if required. As default these two fields are blank. (Note : 
These two field are optional). 

4. Double click on the value in the Start Up field to select the desired option. There are 
3 options, i.e. do nothing, poll and dial then poll. Poll is the default setting. 
 
5. Scheduling features - 
 

Click here on how to use this feature. 

 
 
 
 
Related Topic 

 
Comport Setup. 
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CHANGE PARAMETER SETTING 
 
Steps: 
1. Browse into the StarTime directory (Usually in the Program files/Sierra Technology/StarTime) 
and look for the file named Comm.ini then double click to open it. 
2. Look at the parameter setting: 
[Parameter] 
Company='Sierra Technology' 
Title='StarTime Poller' 
Logo='' 
 
To change the Company name 
 
With the command string: Company = “ “, type your new company name within the boundary range of 
quotation marks. Note: Company description is limited up to 16 characters. 
 
To change the title 
 
With the command string: Title = “ “, type your new title within the boundary range of quotation marks. 
 
To change the logo 
 
Save your logo into the StarTime Directory. For example, your logo is named as mylogo 
To change the logo just edit the command string of Logo=’’ to Logo=’ mylogo.bmp‘. 
To disable logo display, just with this command string: Logo=empty. 
To display Sierra Logo (default), just with command string of Logo=’ ’. 
Note: The logo only support .bmp file and maximum size should be 16 x 16 pixels. 
 
3. Go to File > Save to save the changes made. 
4. Click in the main window of StarTime to quit this software. 
 
Note: User needs to restart the StarTime software in order for the new changes to take effect. 
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CREATE AN USER DEFINED OUTPUT FILE FORMAT 
 
Steps: 
 

1. Proceed to the main window and click on the Option button in the Option window, click on 
the Output tab, then, select a Format Type other than 0 (0 is reserved for default) and click on the 
EDIT button. 
 
2. A new Windows will pop up and show the settings for that particular format. Select the 
keywords in the “Select keywords” list box (leftmost listbox) and click on the arrow button to add the 
keywords to the output string format (rightmost list box). All the keywords, which you have added to 
the right box, will be the output format and the line below it will display how it looks like in sequence. 

 
 
3. “Format Delimiter “ is the character that will separate each field shown in ”Output Format”. If 
you do not wish to have a delimiter, simply leave it blank. 
 

 
4. “Reader No” is the format for Reader Number/ Unit ID. For example, if you set the following: 
Length=3     (maximum is 20) 
Padding=0 
Prefix=K 
Suffix=P 
If the reader number is 5, then the Reader No field will be: K005P 
 
5. “Staff No” is the format for staff number. 
For example, if you set the following: 
 
Case1      
Length=8     (maximum is 20) 
Padding=0 
Prefix=S 
Suffix=<empty> 
If the staff number is A123 then the Staff No field will be: S0000A123 
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Case 2  
Length=5 
Prefix=S 
Suffix= <empty> 
and the staff number is 123-456-678 then the Staff No field 
will be: S123-4 
If Length=0, the output Staff No. field will take its full length. 
 
6. “Unregistered Staff Name” is the message that will be displayed on the online transactions 
window as well as in the translog file when an invalid access card which has not been installed in the 
Employee Data file was being flashed. However you can rename this message. 
 
7. “Mode” length can be set here (maximum length is 20). 
 
8. The Date/Time requires special formatting. To edit the format, click the Edit button at the right 
to the Date/Time fields. A new Windows with the title Edit Date and Time will appear. 
 

 
9. The order of the Date/Time can also be changed according to your personal preferences. 
 

 
10. Once completed, press OK to accept changes. To apply all changes, click Save in the ”Editing 
Format Type # ” Windows. 
 
11. Click on Sample button to see the output file format of Format Type #. 
 



SIERRA ST800TAS StarTime Poller Version 2.11 user manual July 5, 2010 

28 | P a g e  
 

12. Click on Delete button to delete the selected output format. 
 
13. After defining the personal output format, proceed to Comport Setup to assign this new Format 
Type number to the required Communications Port. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Related Topic 

 
Options 
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EDIT A COMM.INI FILE 
 
This is a configuration file for the StarTime. The software will look for these two settings in the INI 
File described below before it runs. 
InstallDelay/SwitchDelay can be found under section [Comm](C:\Program Files\Sierra Technology 
\Startime). If it is not found, user can create it. 
 
 [Comm] 
 InstallDelay=250 
 SwitchDelay=2 
 
1. The use of InstallDelay is to slow down the installation of card no. to the reader. The poller 
may have installed the card too fast, or the speed of the CPU is too fast. This may cause the reader to 
miss some card no. from being installed. To slow down the downloading time, just increase the value of 
the InstallDelay with every increment step of 50. The default value of the delay time is set at 250. 
 
2. The use of SwitchDelay is to delay the communication between the host port and the clock 
reader. This feature is only utilized in cases where if all necessary connections are correct, but the 
application software is unable to communicate with the clock readers or controllers, then increase this 
SwitchDelay value with every increment value of 1. By default, the SwitchDelay value is set at 1. 
 
 Editing COMM.INI file 
 
User can change certain parameters, such as the poller's title, company's logo and name. These 
parameters can be defined in comm.ini. 
 
  [Parameter] 
  Company='My company' 
  Title='TMS poller' 
  Logo='mylogo.bmp' 
 

 
Steps to change the parameter settings. 
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EDITING EMPLOYEE DATA 
 
Adding Employee Data 
 
Steps: 

1. Click on button, or go to Edit > Add to add a record. 
Shortcut: Press ‘Insert’ key from the keyboard. 
2. An add employee windows will pop up for adding employee record. Enter the Card No, Staff 
Name and Staff No and click ‘add’ button to add this record. 
3. This window will allow you to keep on adding records until you click ‘close’ to exit this 
windows. 
Notes: In adding new employee, the application will check for the existence record. If the record is 
already exists with same Card No. or Staff No., it will prompt you a message to ask you whether want 
to add the duplicated record. 
 
4. For the new changes to take place, user has to refresh the controller/clock readers. Proceed to 

main screen and click on Refresh Configuration button, then, press ‘Refresh’ button for the new 
configurations to take effect. Each comport will indicate the percentage already downloaded. 
 
Enable/Disable Employee Data 
 
This function is to enable or disable a staff in the employee file. A disabled record will not be 
recognized or loaded into the system. It is the same as being deleted, but with the record still remain in 
the database. It is a ‘soft’ delete with the option to ‘undelete’. See Remove for total deletion. 
 
To disable a record:- 
 
Steps:          
 
1. Click on the grid that you want to disable the record. 

2. Click on the button. 
3. A disable record will become a yellow color with a semicolon ‘;’ at the start line of the record. 
4. Tips : To enable back a staff record, just follow the above step1 and step 2, then the record will 
be enabled and in a white color in the grid display. 

5. Proceed to main screen and click on Refresh Configuration button, then, press ‘Refresh’ 
button for the new configurations to take effect. 
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Editing Data 
 
User may edit the data directly in the display grid. 
 
Steps:                                        
 
1. Click on the desired data grid until it is editable, or select a white area cells and press F2 to edit. 
Once done, press Enter or click at other cell. 

2. Proceed to main screen and click on Refresh Configuration button, then, press ‘Refresh’ 
button for the new configurations to take effect. 
 
Import Employee Data from Excel File 
 
Steps:                         

1. Click on the button. 
2. An Open dialog box will appear on the screen. Browse the directory for the excel file with the 
employee data, then select the file and click Open. 
 
Export Employee Data to Excel File 
 
Steps:         

1. Click on the button. 
2. A Save As dialog box will appear on the screen. Select your desired directory to save the file, 
enter a file name and then click Save. 
 
Remove Employee Data 
 
Steps : 
 

1. Click in the desired data grid, then, click on button or press Ctrl + Del key from 

keyboard to remove the particular record. Tips: To remove all records just right click on the 
button or proceed to Edit > Remove All. 

2. Proceed to main screen and click on Refresh Configuration button, then, press ‘Refresh’ 
button for the new configurations to take effect. 
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Search Employee Data 
 
Steps: 

1. Click on the button to find text. 
2. Enter the text you want to find. 
3. Select the following conditions that you want to find the text. 
 
• Case sensitive: finding text of ‘Ahmad’ will have difference with ‘ahmad’. 
• Whole words only: it will exactly find the matching whole words text with no case sensitive. 
• Regular expressions: find the matching first character of the words. E.g. ‘AH*’ will search for 
the string that starting with ‘AH’ instances Ahmad, Ahzlan, Ahzan. 
• If you did not select any conditions then it will find the each matching words. 
 
4. Choose the where options, either you want to find the text in entire grid, current column or 
current row. As default, in entire grid will be selected. 
5. Choose the Direction options; either you want to find the text from top to down or left to right. 
As default, the top to down style will be selected. 
 

6. Once done, click ‘Ok’ button to find the text. Press shortcut key F3 or right click on the 
button and select ‘Search again’ to find next data. 
 
Sort Data (check for duplicate data) 
 
Employee data can be sort by Card No., Name or Staff No. 
 
Steps:                        
1. Click on the column header of which data field you want to sort, 
then the data will be sorted in ascending or descending order. 

2. Proceed to main screen and click on Refresh Configuration button, then, press ‘Refresh’ 
button for the new configurations to take effect. 
 
Note: When the records have been sorted, it will check for duplicate records with the same card no or 
staff no. For records with same Card No. or Staff No., the record will be highlighted in blue to indicate 
a duplicate record. 
 
 
 
Related Topic 

 
Employee Data 
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REMOTE COMMAND.TXT 
 
Each communications port can be remotely controlled. There are only a few commands in which the 
user can send to the application from a remote client. These are:- 
 
1. Stop (polling) 
2. Refresh configuration 
3. Synchronize date & time 
4. Stop polling for a while. 
5. Retrieve data 
 
The user will be required to access and modify the parameters in a file called 'remoteCmdN.txt', where 
N = comport number. E.g. To send remote commands to comport 1, change the value at file 
remoteCmd1.txt. Described below is a typical example of how the file appears:- 
 
     [command] 
  Stop=0 
  Wait=0 
  Refresh=0 
  Syncdatetime=0 
 
  [retrieve] 
  controller=0 
  total=0 
 
i) STOP/START POLLING 
 
To stop data polling, simply change Stop's value to 1. To start polling again, change the value to 0. 
Thus, changing this value the application will automatically terminate the wait execution. 
 
ii) PAUSE DATA POLLING 
 
To pause data polling for a while, change the Wait's value to N (where N = numbers of minutes for the 
polling to stop). Hence, to stop the polling for 2 minutes, simply set Wait=2.The Wait's value will 
decrement every minute until it reached 0. You can reread this file again to confirm. Of course, this 
feature will not work if Stop=1, as the application has stopped the polling already. You can immediately 
terminate this wait execution by just setting it back to 0. 
 
iii) REFRESH CONFIGURATIONS 
 
To refresh the entire TMS clock readers of the network, simply set the Refresh’s value to 1, with 
refresh=1. The application will refresh all clocks and resets the value back to default=0. 
 
iv) SYNC ALL CLOCK READERS WITH PC'S DATE & TIME 
 
To enable synchronization of the PC's date & time to all TMS clock readers, simply set the 
SyncDateTime’s value to 1, SyncDateTime=1. To disable this feature, simply set the value to 0. 
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v) TO COMMAND SYSTEM TO RETRIEVE DATA FROM A CLOCK 
 
To retrieve data from a clock again, under section [retrieve], assign the clock address number to 
parameter controller, Controller=<clock address> and set the value of Total=<total number of records 
to poll>. Hence, to retrieve 10 records from clock 1, the following example illustrates:- 
 
       [retrieve] 
  controller=1 
  total=10 
     
 
The system will reset the total's value back to 0, indicating that it has received command and is 
retrieving the records. 
 
With each single file for each comport, the user can individually control each data polling of a comport. 
For the user to control all the comports polling, the user can use the master remote command file for all 
comports which is describe next. 
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REMOTE COMMAND OF ALL COMPORTS 
 
Remote command of all comports 
 
User can remotely command all communications port data polling with a single file named 
'remoteCmdAll.txt'. This is a master file for all the communications ports. The significance between 
single comport command file and master command file is the control of reader polling wait time. 
 
In the master command file, it looks like this: 
 
     [Command] 
               MinutesPaused=0 ;  <=== equivalent to 'wait' in a 
                                                                     single command file 
    NoWait=0                      ; to terminate wait loop, set it to 1. 
    Refresh=0 
    Stop=0 
    SyncDateTime=1 
 
i) TO STOP/START ALL POLLING 
 
To stop all data polling process, set the value of Stop to 1. 
To reinitialize or restart data polling, simply reset the value back to 0. 
 
ii) TO REFRESH CONFIG TO ALL COMPORTS 
 
To refresh all the clock readers at all comports, simply set the Refresh's value to 1, refresh=1. The 
application will refresh all clocks and will automatically resets the value back to 0. 
 
iii) TO SYNC THE PC'S DATE TIME TO ALL THE CLOCKS 
 
To enable synchronization of the PC's date & time to all TMS clock readers at all the comport, simply 
set the SyncDateTime's value to 1, SyncDateTime=1. To disable this feature, just set the value back to 
0. 
 
iv) PAUSE ALL COMPORT DATA POLLINGS 
 
a) To pause all comports from polling for N minutes, set the value of MinutesPaused=N. The 
application will reset it back to 0, indicating that it had sent the value to all the comport’s polling wait 
time. 
 
b) To clear the paused time, just set the NoWait=1. The application will reset it back to 0, 
indicating that it had reset all the wait time of all the comport polls. 
 
 
 
Related Topic 

 
Remote Command Text 
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SCHEDULING FEATURES 
 
The scheduling features are only applied for the Modem type. Schedule can be set in an Hourly, Daily, 
Weekly, On Weekdays, Monthly or no scheduling mode. Furthermore, user can set how many seconds 
to close the connection of no data receiving. 
 
From the comport setup window, select the scheduling column of the comport that is set to modem type. 
Click the input box again until the ellipsis button appeared. Click the ellipsis button at the right side of 
the input box. The scheduling setup window will display on screen. 
 
For example:  To set schedule mode in Hourly. 
 

 
Steps: 
To set the event occur at 15 minutes past the hours, change the value at the Occur At box, as shown 
below to 15. 
 

 
To set the close connection after a period of 15 seconds of no data receiving, change the value at the 
Close connection after box to 15. Let say if you have two dialing numbers: the system will dial the 
first number and start to poll data from the controllers. It will continue to poll until there are no data 
received from any of the controllers for about 15 seconds. It will then close the connection and 
continue with the next dialing number to dial. It will repeat the same polling process until there are no 
data received for 15 seconds, which it will then close the connection. 
 

 
User can select the dialing number by ticking the dialing number from the dialing number box. 
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User can edit the dial number in the scheduling setup by following the steps of below. 

First, click on the button, if you want to: 
 
i) Add a dial number 
Click on the list box, then press <Insert> from keyboard to enter a dial number and then press Enter to 

accept. Press <Insert> again to add another dial number. After that, click the button to finish. 
 
ii) Edit a dial number 
Select the dial number that you want to edit, click the number again until it is editable. Press Enter to 

accept the change or click at other location within the box. After that, click the button to 
finish. 
 
iii) Delete a dial number 
In the list box, select the dial number that you want to delete, then press <Delete> from keyboard to 

delete the unwanted dial number. After that, click the button to finish. 
 
Once this is completed, click ‘Ok’ button to accept new changes. To ignore the new changes, click on 
‘Cancel’ button to quit. 
 
NOTE: Any changes made to these files will require the user to refresh the controller/clock readers. 

Click on Refresh Configuration button to enable the new configurations to take effect. 
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SET CLOCK CONFIGURATION 
 
Steps: 
 

1. Proceed to main window of StarTime and then click on the Configuration button. 
2. Select which comport you want to load and then click ‘Open’ button. 
3. Then the ConfigComN.txt with the Notepad format will be shown on screen. Note: Each 
communications port has its own configuration file (ConfigComN.txt, where N=comport number). 
 
 Example of ConfigCom2.txt contents   
 
 Main, ”StarTime Clock“ {a} 
 
 Mode, 1,Morning In  {b} 
 
 Siren, 1, 0,9:00,15 
 Siren, 2,1,13:00,20  {c} 
 
 CheckCard, 0   {d} 
 
 IndicatorTime, 5  {e} 
 
a) To edit the LCD display message 
 
User can define it own unique message for the reader display screen. The default LCD Display 
message is “StarTime Clock”. To edit the LCD display message just erase the “StarTime Clock” text 
and type your desire display message in the boundary range of quotation mark (“”). E.g. to change the 
LCD display message from ‘StarTime Clock’ to ‘Sierra TMS Poller’, just, type “Sierra TMS Poller” in 
the ConfigComN.txt. Note: Maximum length for the message displayed is limited by the maximum 
characters (in horizontal line) for that LCD, typically 16 characters. 
 
b) To set the mode function 
 
Mode function is to assign an ‘event’ to the keypad number on the reader. For example, assign a keypad 
number 4 to ‘Tea Break’ just with the command string: Mode, <Keypad number> , <description> in the 
ConfigComN.txt. Note: Allow mode is from 0 - 9. 
 
c) To set clock siren settings 
 
The clock reader has a feature that can give to a ‘beeping’ siren at a certain time of a day, which is 
defineable by the user. The command string is: 
Siren, <day>, <setting number>, <time>, <duration> 
where 
day = 0 - 6 ;  { 0-Sunday, 1-Monday, 2-Tuesday, 3-Wednesday, 4-Thursday, 5-Friday, 6-Saturday} 
Setting number = 0 - 63;               {64 settings per day} 
Time = 00:00 - 23:59;    {24 hours mode} 
Duration = 0 - 99 seconds 
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For example, to create a new siren on Friday at time 5:30 pm for 20 seconds with the setting number of 
3 just typing Siren, 5, 3, 17:30, 20 in the ConfigComN.txt. 
 
d) To accept all cards or accepts only installed cards from the EmpData.txt. 
 
Command string : CheckCard, x , where x= 0 or 1 
e.g. 
 
• CheckCard, 0 - Clock reader will only accept card that is installed in the reader. 
• CheckCard, 1 - Clock reader will accept any card, installed or not installed in the reader. 
The only difference is, for an installed card, a cardholder name will appear when the card is flashed, 
and otherwise it will only show the card number. 
 
e) To indicate the trigger relay time on a valid swipe. 
 
The clock reader is able to trigger an output relay on an accepted card flashed for a duration of time. If 
this relay is connected to an external device such as indicator light or a buzzer, it will trigger it for that 
duration of time. For example: IndicatorTime, 5 meaning that the output relay will trigger and hold for 
5 seconds of a valid swipe. Note: Duration range is from 00 – 99 seconds. 
 
4. Go to File > Save to save the changes made. 
5. For new changes of settings to take effect, user must refresh all the connected clock readers. 

Proceed to main window and click REFRESH CONFIG button to refresh or upload the entire new 
configurations for the changes to take place. 
 
 
 
 
 
 
Related Topic 

 
Configuration File 
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